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 Welcome to the world of TK-78K0R/KG3+UZ. 
  
You are now being navigated to the design environment 
of the 78K0R microcontroller for developing wireless 
network applications. Please follow the tutorial step by 
step. 
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[NOTES] 
The information in this document is subject to change without notice. No part of 
this document may be copied or reproduced in any form or by any means without 
the prior written consent of TESSERA TECHNOLOGY INC. 
TESSERA TECHNOLOGY INC. assumes no liability for infringement of patents or 
copyrights of third parties by or arising from use of a product described herein. 
This product is designed and manufactured with intention for use in evaluation 
and prototyping by engineers with knowledge of security, safety and reliability. 
TESSERA TECHNOLOGY INC. would like to inform, that the standard quality 
assurance procedure(s) have not been fully applied to this product and its 
documentation and that TESSERA TECHNOLOGY INC. cannot assure the full 
and error free function and/or the standard quality level. 
[CAUTION] 
This equipment should be handled like a CMOS semiconductor device. The user 
must take all precautions to avoid build-up of static electricity while working with 
this equipment. All test and measurement tool including the workbench must be 
grounded. The user/operator must be grounded using the wrist strap. The 
connectors and/or device pins should not be touched with bare hands. 
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1 Introduction 
 
 
 
Target Reader Software development engineers who wish to become 

familiar with the development environment of the 78K0R 
microcontrollers. It is assumed that the readers have been 
familiar with basics of microcontrollers, C and assembler 
languages, and the WindowsTM operating system. 

 
Purpose For readers to become familiar with the design environment 

and the application examples of wireless networks. 
 
 
Overview This manual consists of the following contents 
 
Chapter 1 Introductions 
              →Overview of this manual 
 
Chapter 2 Preparations 
              →Introduction of soft tools, and sample programs and installation 
 
Chapter 3 Experiences 
              → Guide to the basic operations of PM + and the integrated 

debugger using sample programs. 
 
Chapter 4 IEEE 802.15.4 MAC Sample Programs                                           
              → Learn sample programs, which utilize the MAC library 
 
Chapter 5 Mode Setting of the Board 
  → Explanation of switch setting. 
 
 
Trademark Microsoft and Windows are either registered trademarks or 

trademarks of Microsoft Corporation in the United States and/or 
other countries. 
Adobe and Acrobat are trademarks of Adobe Systems 
Incorporated (Adobe System Incorporated). 
Other company names and product names that appear in this 
document are the registered trademarks or trademarks of their 
respective companies. 
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2 Preparations 
 

 
This chapter introduces the development environment and describes how to 
install the sample programs. The sample program can be tested on this 
hardware platform of the evaluation kit. 

 
 
 
 

 



- 9 - 

2.1 Development Tools, Sample Programs, and the MAC Library 
 
 
 

 
This section outlines the development tools, sample programs and the MAC 
library used in this tutorial.  

 

2.1.1 Integrated Development Environment PM + V6.30 
This is a project manager, where you work for editing the source code, 
compiling it, and initiating the debugger. The project manager works on MS 
Windows 2000 or XP.  

 

2.1.2 Device file DF781188 V3.00 
A device file contains an MCU specific information. It instructs the 
development tools what kind of an MCU the tools shall work for.  

 

2.1.3 C Compiler CC78K0R W1.20 : Code size limited version 
This is a free compiler for the 78K0R microcontrollers. The object code size 
is limited to 64 Kbytes. It works on MS Windows 2000 or XP. 

 

2.1.4 Assembler RA78K0R W1.10 : Code size limited version 
This is a free assembler for the 78K0R microcontrollers. The object code 
size is limited to 64 Kbytes. It works on MS Windows 2000 or XP. The 
RA78K0R Assembler Package contains Structured Assembler 
Preprocessor, Assembler, Linker, Object Converter, Librarian, and List 
Converter. 
 

2.1.5 78K0R integrated debugger ID78K0R-QB V3.40 
The Integrated Debugger ID78K0R-QB offers a debug environment on 
your PC, where the MS Windows 2000 or XP runs, if the TK board is 
connected to the PC with USB. The USB I/F accesses to the OCD, On 
Chip Debug, interface on the microcontroller.  

 

2.1.6 78K0R Starter Kit Setting 
If you forget about the security ID or if you set “Does not erases data of 
flash memory in case of failures in enabling on-chip debugging”, you can 
erase the flash memory by using this starter kit. 
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2.1.7 USB driver  
This is a software driver for PC to access to the USB interface of the 
TK-78K0R/KG3+UZ board.  

 

2.1.8 The RF Test Program 
The RF Test Program is used in [chapter 3 Experiences]. 
 
The RF Test Program is provided in the form of the C source codes.  
 
If you wish to tailor the RF Test Program to meet your specific needs, you 
can edit the source code, re-compile it with debug build to generate a load 
module file, then, start the debugger to load the tailored execution code on 
to the microcontroller for further debugging on the project manager PM +. 
 
Alternatively, if debugging is not required, you can make a release build to 
achieve a new hex file, on the project manager PM +. 
 

As a general remark, please respect your local regulation of 
electro-magnetic emission. In general, it is suggested to use the 
TK-78K0R/KG3+UZ board in a radio anechoic chamber. 
 
 

2.1.9 IEEE 802.15.4 MAC Library 
The IEEE 802.15.4 MAC Library offers an executable object-code library of 
the MAC stack specified in the IEEE 802.15.4. Please refer to the MAC 
Library manual for further details. 
 

2.1.10 The MAC Sample Program1 : Text Chat Program 
The MAC Sample program 1 is developed to provide with a simple 
example to construct a star network utilizing the IEEE 802.15.4 PHY/MAC 
standard. 
 
The MAC Sample Program 1 offers, 
1). Designation of a network coordinator in a star configuration 
2). Text chat between a coordinator and an end device 
 
To use the MAC Sample Program 1, you need to prepare at least two PC 
with a USB interface and two TK-78K0R/KG3+UZ boards.  
The MAC Sample Program 1 is provided in the form of the C source 
codes.  
 
If you wish to tailor the sample program to meet your specific needs, you 
can edit the source code, re-compile it with debug build to generate a load 
module file, then, start the debugger to load the tailored execution code on 
to the microcontroller for further debugging on the project manager PM +. 
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However, because the USB connection to instruct operation to the program 
is occupied for the debugging purpose,  
alternatively, you can make a release build to achieve a new hex file, on 
the project manager PM +. 
 

As a general remark, please respect your local regulation of 
electro-magnetic emission. In general, it is suggested to use the 
TK-78K0R/KG3+UZ board in a radio anechoic chamber. 
 
 
 

2.1.11 The MAC Sample Program2 : LED Control 
The MAC Sample program 2 is developed to provide with another simple 
example to construct a star network utilizing the IEEE 802.15.4 PHY/MAC 
standard. 
 
The MAC Sample Program 2 offers, 
1). Designation of a network coordinator in a star configuration 
2). LEDs on the coordinator board indicate which switch on which end 

device is pressed. 
 
To use the MAC Sample Program 2, you need to prepare one PC with a 
USB interface and two TK-78K0R/KG3+UZ boards or more boards, up to 
5.  
The MAC Sample Program 2 is provided in the form of the C source codes.  
 
If you wish to tailor the sample program to meet your specific needs, you 
can edit the source code, re-compile it with debug build to generate a load 
module file, then, start the debugger to load the tailored execution code on 
to the microcontroller for further debugging on the project manager PM +. 
However, because the USB connection is occupied for the debugging 
interface, the USB connection is not available for applications. Alternatively, 
you may make a release build to achieve a new hex file, on the project 
manager PM +. 
 

As a general remark, please respect your local regulation of 
electro-magnetic emission. In general, it is suggested to use the 
TK-78K0R/KG3+UZ board in a radio anechoic chamber. 
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2.2 Installation of Software Development Tools 

 

 

2.2.1 Start-up of the installation CD-ROM 
 
The attached CD-ROM contains Development Tools, documents and sample 
soft ware.  
You can install it using an installer. 
 

2.2.2 Installation of the software development tools. 
 
Please insert the CD-ROM in the drive. The installer will show up automatically. 
If it does not start automatically, please initiate it by double clicking the 
SETUP.EXE. 

 

 
 

 
<1> Readme First 

The contents of the CD-ROM, and some notes are available. 
Please read it at first. 

<2> Install… 
Click “Install” to start installation of development tools. 
For details, please refer to the next section. 
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<3> Documents 
Manuals of development tools and the evaluation kit are available in PDF 
files. 
When this button is clicked, the WWW browser will start. Adobe® Acrobat® 
Reader is available in the CD-ROM. 

     
<4> Sample Program 

Click this button to start the WWW browser for the sample program and the 
tutorial. 

<5> Link to NEC Electronics Microcontrollers   
Click this button to start the WWW browser display the link to the NEC 
Electronics Microcontroller web site 
(http://www.necel.com/micro/index_e.html) 
The NEC Electronics Microcontroller web page provides with the latest 
product/tool information and FAQs.   

<6> Exit  
Terminate the setup. 
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① Select products that you need to install. 

(as default, all the products that you need to use the demostration kit 
are selected.) 

"Explain" area displays an explanation of the selected product. 
To change the installation destination, click  Browse…  . 

 
When all the settings are completed, click  Install…  .  
 

* In this document, it is assumed that users install the programs under "NEC 
Electronics Tools" directory (default installation directory). Users can find the 
tools by selecting “Start Menu” -> "Programs" -> "NEC Electronics Tools".  
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② Click  OK  when "Install" comfirmation dialog box is opened. 
 

 
 
 

③ Read "software license agreement" and click  Yes  for continuing the
 installation.To stop the installation, click  No  .  
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④ Enter the product ID, and click  Next  . 
* The product ID is available on the “README.html” the other sheet. 

 

 
 
 

⑤ It starts copying the files.  
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⑥ Click  Next  when "Select Files" installation wizard dialog opened. 

 
 

 
⑦ When the installation is completed, the following dialog opens. 

Click  OK  .  
 

 
 
 

⑧ "NEC Electronics Starter Kit Virtual UART" USB driver must be install
ed on PC before you connect to TK-78K0R/KG3+UZ. Install the USB
 driver by referring "2.4 USB Driver".  
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 Notes on the installation authority  
To install this tool in Windows 2000 or XP, the authority of a administrator is 
necessary. Therefore, please login as an administrator. 
 
 Notes on the install-directory  
Please do not use 2-byte characters, such as umlaut in the directory name, 
where the product is to be installed. 
 
 Note on the version of Windows  
If the language of the Windows is not English, a file transfer error during 
installation might be observed. In this case, please abort the installation in 
the language, and re-install it in an English version of Windows. 
 

The identical problem may be observed, if a language other than English is 
specified as the system language in the “Regional Settings Properties” tab. 
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2.2.3 Uninstall 
 
<1>  Start "Add /Remove Programs" in the Control Panel. 

(Example here is based on Windows2000) 
 

 
 
<2>  Select the tool that you want to uninstall from the list displayed in 

"Install/Uninstall" and click [Add/Remove...]. 
 
 
<3>  A dialog box for confirming deletion of files will be displayed.  Click    

Yes   .  Deleting of the files will be started. 
 

 
 

 
<4>  When the completion message is displayed, click    OK   . 

 
Caution: 
Deletion of some files may be asked during uninstallation.  Normally, 
deletion of these files causes no problem.  

 
<5>  This completes uninstalling this tool. 
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2.2.4 File Configuration in PC 
 

Software Development Tools are installed in "C:¥Program Files¥NEC Electronics 
Tools" on default setting. 
When you use the tools, please open the tools from [Start menu] -> 
[Programs]->[NEC Electronics Tools]. 
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2.3 Sample Environment 

 

 

 
This section explains the overview and preparation of sample programs. 
You need to install the sample programs on your system first before using them. 

 
How to install the sample programs and where they should be intalled on your 
system will be explained. 
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2.3.1 Installation of the sample programs 
Insert the CD-ROM disk in the CD-ROM drive of your PC. The [NEC Electronics 
Microprocessor Development Tools Setup] screen automatically appears.(if this screen does 
not appear automatically, start setup.exe from Explorer. etc.) 
Press the  Sample Program  button to start the WWW browser, and then click the 
[TK-78K0R/KG3+UZ Sample Programs] link.  

   

 

 
 

When[TK-78K0R/KG3+UZ Sample Programs] is clicked, the following 
download confimation window appears. 

The WWW browser 
starts up. 

Click the [TK-78K0R/KG3+UZ 
Sample programs] link you can also 

download the [Tutorial Guide] 
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Please click the Open button. 
In case of windows 2000, 

you will see the [Security Warning] window. Please click  Run . 
 

 
 

 
 

InstallShield wizard for TK-Sample Program starts up  
Please click  Next. 
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License agreement screen is displayed. 

Please select "I accept the terms in the license agreement".and click Next. 
 

 
 

 
 

Please click Finish. 
 
 
The sample programs are installded under "C:¥" now. 
 
The sample program "TK78K0R.EXE" with self-extract file is also intalled. When 
you need to use the original sample programs, you can extract the file 
"C:¥TK78K0R.EXE". 
 
When you uninstall the sample program. 
Please use "Add /Remove Programs" in the Control Panel. 
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2.3.2 File Configuration of the sample program 
 
The sample programs ware the following folders. 
 

 
 
 
 
 
 
 
 
 
 
 

TK78K0R 

SAMPLE_KG3+UZ 

 

TK78K0RUZ_RF_Test The sample program used in chapter 3. 

The packet error rate and received signal 

strength indication are monitored.  

TK78K0RKG3UZ_Sample1 This sample program uses MAC library. 
The text message is transmitted and it receives it. 

TK78K0RKG3UZ_Sample2This sample program uses MAC library. 

Switch information is transmitted, it receives,  

and LED is blinked.. 
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2.4 USB Driver 
 
 
 
You need to install “NEC Electronics Starter Kit Virtual UART” in your PC.  
 
When TK-78K0R is used, it is necessary to install the “NEC Electronics Starter Kit Virtual 
UART” driver in the host machine. Please install the driver according to the following 
procedures with appending CD in the drive. 

 
"Starter Kit USB Driver" must be installed on the PC. If not, please refer to "2.2 Installation of 
Software Development Tools" to install the “Starter Kit USB Driver” first.  

 
Attention  Do not use a USB hub for connecting TK-78K0R/KG3+UZ. 

 
 
Depending on the version of Windows OS, the installation will be differed.  
Please check your Windows version, and follow the instructions 
   - Windows XP   -> "2.4.1 Installation to Windows XP" 
   - Windows 2000 -> "2.4.2 Installation to Windows 2000" 
After the installation, go to "2.4.3 Confermation of the installation" 
 
 

8
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2.4.1 Install to Windows XP 
 

１． Once the TK-78K0R/KG3+UZ is connected with USB, the "Found New Hardware 
Wizard" will be started. Select "No, not this time" and click  Next >  .  

 

 
 
 
２． Select "Install from a list or specific location" and click  Next >  .  
 

 

Select "Install from a list or specific 

location" 

Click "Next" 
 

Click "Next" 
 

Select "No, not this time" 
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３． Select "Search for the best driver in these locations.” , check "Include this location in 
the search:", and then click "Browse..." to select the driver directory path. The path 
should be "C:¥Program Files¥NEC Electronics Tools¥TK-driver" as default installation. 
If the installation directory is not default, then select "TK-driver" under the installation 
directory.  
Click  Next >  . 

 

 
 
 
４． If the following dialog is opened, click  Continue Anyway  .  

 

 
 
 

Click "Next" 

Click "Continue Anyway" 

Select the driver directory 
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５． The installation of "NEC Electronics Starter Kit Virtual UART" driver is completed.  

Click  Finish  . 
 

 

 
 
６． Go to "1.3.3 Completion of the installation". 
 

 

Click "Finish" 
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2.4.2 Install to Windows2000 
 

１． Once the TK-78K0R/KG3+UZ is connected with USB, the "Found New Hardware Wizard" 
will be started.  
Select "No, not this time" and click  Next >  .  

 
 
 

 
 
 

Click 
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２． Select "Search for a suitable driver for my device". 
Click  Next >  .  

 

 
 
 

３． Select "Specify a location". 
Click  Next >  .  

 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click "Next" 

Select "Search for a suitable driver for my 

device" 

Click "Next" 

Select "Specify a location" 
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４． Select the driver directory path. The path should be "C:¥Program Files¥NEC 
Electronics Tools¥TK-driver" as default installation. 
If the installation directory is not default, then select "TK-driver" under the installation 
directory.  
Click  OK  . 

 

 
 
 
 
 
 
５． Click  Next >  .  
 

 

 
 

 
 

Click "Next" 

Click "OK" 

Select the driver directory 
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６． The installation of "NEC Electronics Starter Kit Virtual UART" driver is completed.  
Click  Finish  . 

 

 
 
 
 
 
７． Go to "1.3.3 Confirmation of the installation". 

 
 

Click 
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2.4.3 Confirmation of the installation  
 
Please confirm “NEC Electronics Starter Kit Virtual UART(COMx)” in the device 
manager of system in the control panel of the MS Windows.  
 
 

Device Manager 

 
 
The screen above shows that the COM port number is "COM8". If ID78K0R-QB is 
not in use, you can use this port number for connecting TK-78K0R/KG3+UZ. 
When you change the USB port connection, the COM port number will be 
changed as well. 

 
 

CAUTION 
・Do not do “Hardware Modification Scan” when you communicate with the target device. 

 
 

It is confirmed that “NEC 

Electronics Starter Kit Virtual 
UART(COMx)” exists.  



- 35 - 

3 Experiences 
 
 
Now you are ready to experience the operation of the TK-78K0R/KG3+UZ using 
the integrated development environment, PM +. 
 
As a program for the 78K0R/KG3, the RF test program (RF_Test) which you 
installed in "2.3.1 Installation of the sample programs" is used. 
You use two of 78K0R/KG3. One is the stand-alone system with USB power 
supply. Another is connected to the debugger and run user programs. By building 
the sample programs and operating with ID78K0R-QB, you can understand the 
basic operation of the development tools (PM+, ID78K0R-QB) and the basics of 
the project files that you need when you develop application programs. 
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The overall flow is as follows. 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Starting integrated debugger (ID78K0R-QB) 

Executing program 

Stopping program 

Operation 

Terminating integrated debugger (ID78K0R-QB) 

Loading workspace (project) 

Creating execution format 

Reviewing Linker, Compiler option, Debug setting 

TK board setting 

Starting PM + 

Terminating PM + 
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3.1 Starting PM + 
 
 

 

In the Windows Start menu, select [Programs]->[NEC Electronics Tools]->[PM + 
V6.30] 

 
 
 
 
 

 
 
 
 
 

PM + start up 
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3.2 Introduction to PM + 
 
 
 
In PM +, application programs and environment setting are handled as a single Project, and series of actions 

such as program creation using the editor, source management, build, and debugging are managed. 

Also, one of more project files is managed together as a workspace. 

 

 

 

 
 
 
 
Project window A window in which project names, source files, and include file are displayed using a 

tree structure. 

Output window A window in which the build execution status is displayed. 

 

For details regarding menu bars and tool bars, refer to the PM + User’s Manual. 

 

Project window Output window 

Tool bar 
Menu bar 
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What is a project? 

A project is the unit in which PM + executes management, and refers to an application system 

and environment development based on PM +. 

PM + complies project information and saves it in a “project file”, from which it is then referenced. 

 

What is a project file? 

A project file is a file to which information such as the source file to be used in the project, the 

device name, the tool options for complying, and the editor and debugger to be used have been 

saved as “project information”. 

The file name format is “ΔΔΔΔprj”. 

Project files are created in folders that are set when creating new workspaces. 

 

What is a project group? 

A project group is a group comprised of a number of projects in an application system. 

The target devices of each project that can be registered to one project group must be the 

same. 

 

What is a workspace? 

A workspace is the unit used to manage all the projects or project group required for one 

application system. 

The file name of multiple project files is saved to a workspace file for referencing. 

The file name format is “ΔΔΔΔprw”. 
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3.3 Loading Workspace (Project) 
 
 

 
In this section, you will use the workspace that you created in "2.3.1 Installation of 
the sample programs" 
For creating a new workspace, refer to "3.15 Creating a new PM + workspace 
(project)". 
The workspace has information about the build environment for the sample 
programs. 
Select "File" on menu bar and "Open Workspace…". 
Then, select 
“C:¥TK78K0R¥SAMPLE_KG3+UZ¥TK78K0RUZ_RF_Test¥RF_Test.prw” . 
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“RF_Test.prw”and then press the  Open  button. 

 
 

 

 
 
 

Open the folder in which the 

sample program is located. 

Workspace file name :RF_Test.prw 

Project group 

Project 

The “RF_Test.prw” workspace 

file is read 
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3.4 Configuration of Linker Option 
 
 
The linker options have been set by the project file. However, some option settings will be 
covered in this section because the linker option settings are important for debugging. 
Following three settings are covered specifically. 
  - Outputs from debugging 
  - On-chip debug (bytes, security ID) 
  - Watchdog timer 
 
Select "Tools" on menu bar, then "Linker options". 
 

3.4.1 "Output1" Tab 
Select "Output1" tab on "Linker Options" window, and see following settings. 
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  - Load Module File settings 

Check "Output Symbol Information". 
This enables to do source level debugging (setting break points, monitoring variables in 
watch window, etc). 
Also, you can specify the load module file name.  
 

  - On-Chip Debug Option Byte 
Check "On-Chip Debug Option Byte". Enter "85" in "Control value". This setting enables 
the on-chip debugging function of the microcontroller. 
    *For details of "Control value", refer to the user's manual of 78K0R/KG3 (U17894E). 
See "Start address" is set to "7FC00", and "Size" is set to "1024". 
These settings reserve the memory address area for the monitor program (the flash 
memory area that the debugger uses for on-chip debugging). 
In this case,  the "Control value" is allocated to the address of C3H in flash 
memory, and FFH is set to the next address. Because of this, the following areas could 
not be set the segments. 
<Address area that reserved by on-chip debugging> 
  - 2H, 3H 
  - CEH-D7H 
  - From the address set in "Start address" to the byte set in "Size" 

 
  - Security ID 

Check "Security ID", and enter the security ID which is a unique ID code (10 bytes) to 
authenticate when the debugger is launched.  
The security ID is stored in the flash memory (C4H-CDH), and checked if it is the same 
as the code entered in Linker options dialog when the debugger is launched. 
The debugger will not be launched when the security ID is unmatched. By using this 
function, you can secure the programs from leaks. 
If you do not need to set the security, it is recommended to set the security ID 
"FFFFFFFFFFFFFFFFFFFF" as this is the initial code. 

 
If you forget about the security ID (stored in the address of C4H-CDH) or if you set wrong 
on-chip debug option byte, you will not be able to use the debugger (ID78K0R-QB). 
To solve this, you can use the "78K0R Starter Kit Setting" for changing the setting to initialize 
the flash memory at the time debugger launched. 
For details, refer to "3.9 Starting integrated debugger (ID78K0R-QB)". 
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3.4.2 "Output2" Tab 
Select "Output2" tab on "Linker Options" window, and see following settings. 
 

 
 
  - User Option Byte 

Check "User Option Byte", and then enter "00FFFF". Here, you can do the 
setting of watchdog timer, low-voltage detector, and system reserved 
memory area. The 3 bytes you entered are stored at C0H-C2H on flash 
memory: 
  - C0H: setting for watchdog timer 
  - C1H: setting for low-voltage detector 
  - C2H: setting for system reserved memory area (must be set as FFH) 
This time, you disabled the watchdog timer and the default start function of 
low-voltage detector. 
For details, refer to the user's manual, 78K0R/KG3 (U17894E). 
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3.5 Configuration of Compiler Option 
 
 

 
The compiler options have been set by project file. However, because some compiler options 
are useful, following two settings are covered specifically in this section. 
  - Enable C++ comments 
  - Use multiplier and divider 
 
Select "Tools" on menu bar, then "Compiler options". 
 

3.5.1 "Extend" Tab 
Select "Extend" tab, and check "Enable C++ Comment". 
This setting allow you to use the C++ comment using "//". 
It is useful feature when developing code. 
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3.5.2 "Startup Routine" Tab 
 
Select "Startup Routine" tab, and check "Using Library" and "Using 
Multiplier/Divider". The 78K0R/KG3 has feature of multiplier/divider to increase 
those calculation speed. 
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3.6 Configuration of Debugger setting 
 

 
 
 
Please Choose [Tool] -> [Debugger Setting] at the pull-down menu. 
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Check if "ID78K0R-QB V3.40 78K0R Integrated Debugger" is selected on "Debugger". 
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JP1 

SW1 

3.7 TK board setting 
 

 
Please set the switches on the TK-78K0R/KG3+UZ board as follows. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

  
 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
After the switch settings are completed, connect the PC to USB1 on 
TK-78K0R/KG3+UZ with USB cable.If the "Found New Hardware Wizard" is 
started, install USB driver with referring "2.4 USB Driver". 

JP1 1-2 short (USB side) 
Bit1 ON 
Bit2 ON 
Bit3 ON 
Bit4 OFF 
Bit5 OFF 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
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3.8 Creating execution format 
 
 
 
Please go back to PM +. 

Please re-compile the project by clicking the  button at the menu bar. 
 

 

 

 
Build has been completed successfully.

Build process is  

executed 



- 51 - 

 
 

What is build ? 
Build is a function that creates an executable file, etc., from a source file registered to a project. 

PM + automatically performs compiling, linking, and other processing actions. 

On the second and subsequent build, PM + also automatically delects files that have been updated  

from the previous build processing, and complies and assembles only the relevant files, thereby reading 

the time required for build processing.  
 
 

What is rebuild ? 
Build compiles and assembles only the source files that have been updated since the previous 

time, whereas rebuild compiles and assembles all the source files.  

When setting, such as compiler options, have been changed, not build, but rebuild, must be  

Selected. 
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3.9 Starting integrated debugger (ID78K0R-QB) 
 
 
 
Please select the Debug button  ，of PM +, or in the menu, select [Build(B)]
→[Debug(D)]. 
 
 

 

 

 

  

 

 

 

 

If the debug button is not displayed, in the menu, select [Tool]→[Debugger 
Setting...]“ID78K0R-QB V3.40 78K0R Integrated Debugger” 

ID78K0R-QB is launched 
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"Configuration" dialog is opened. 
Enter "FFFFFFFFFFFFFFFFFFFF" (F x 20) in "ID Code", then click  OK  . 

 

 
Click  Yes  when the confirmation dialog for downloading load module file is opened. 
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NOTE: 

Completion of the download does not mean running the programs. To run the sample 
programs, go to "3.11 Executing program". 

 

 

 

ID78K0R-QB starts and downloading 
the program to flash memory. 

When the download is 
completed, the source 
code will be displayed 



- 55 - 

Normally, if communication with the CPU fails, the following error messages are 
output. 
 

 
 
If you observe the message please confirm the following items.  
 
 
 
1． Please confirm the switch on the board is set as follows. 
 
 
 
 
 
 
 
 
 
 
 
 
２．  Please confirm the power LED1 is lighted. 
 
 
After checking the above items, start ID78K0R-QB again. 

 
 
 

JP1 1-2 short (USB side) 
Bit1 ON 
Bit2 ON 
Bit3 ON 
Bit4 OFF 
Bit5 OFF 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
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If the ID code is wrong, you may find the following messages on the display. 
 

 
 

The following "Configuration" screen is displayed when OK is pushed and input a correct ID 

code, please. 

 
 
If the setting of On-Chip Debug Option Byte is "Does not erases data of flash 
memory in case of failures in enabling on-chip debugging" and if you forget the 
security ID, you need to erase the CPU built-in flash memory. 
Ｔo erase the data in flash memory, do following steps. 
 
Double-click to open the file "exk0r32ocfg.exe" under the directory "C:¥Program 
Files¥NEC Electronics Tools¥TK-driver" (as the installation directory is default). 
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"78K0R Starter Kit Setting" starts. 
Set "Flash Memory" to " Erase flash memory at debugger start up ", then click "Setting". 

 

 
 
Restart the integrated debugger (ID78K0R-QB). 
   
When you could confirm the debugger is working, open "exk0r32ocfg.exe" again. This time, 
select "KEEP flash memory at debugger start up", then click Setting. 
(Because there is a limit of erasing times for flash memory, it is recommended to try not to 
erase flash memory many times) 
 
 
※ ID Code 
The ID Code is a mechanism to prevent an unwelcome third party from accessing your 
source code by initiating the debugger. Therefore, it is recommended to modify the ID Code 
from the default value to secure your original source code. However, once you modify it, then, 
if you forget the security ID or mistakenly over-write 0x00(value) to the address of 0xC3, the 
debugger ID78K0R-QB is unable to access to the CPU via OCD interface. In this case, you 
have to start over from erasing all data in the Flash EEPROM. Then, you can define the new 
ID Code. You may load your source code from the debugger with a load module file. 
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3.10 Introduction of integrated debugger(ID78K0R-QB) 
 
 
 
ID78K0R-QB displays the internal status of the CPU and controls monitor 
functions in the main window.  
The initial screen of ID78K0R-QB is as follows.  
 
< Main window＞ 

 
 
 
 

 
For more details, please refer to the user’s manuals of ID78K0R-QB. 

 
 

Status bar 

Menu bar 

Window display area 

Tool bar 
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3.11 Executing program 
 
 

If you click “GO” , the execution of the code will start. 
You can know it by the red bar at the bottom. 

 

 

 

 
 
 

When programs are running, the status bar will be red. 

Execute the program 
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3.12 Stopping program 
 
 
Now, you are going to stop the program. 
Press the ID78K0R-QB’s stop button , or in the menu, select [Run]→[Stop]. 

 

 

 
 
When the program stops, the status bar changes back to the original color. 
 

 
 
 

Stop the program 
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3.13 Terminating integrated debugger (ID78K0R-QB) 
 
 

Select "File" on menu bar, then "Exit". 
 

 
 
 
 

 
 

 
 
 
If you push the “Yes”, ID78K0R-QB is terminated after preserving a present 
environment.  
If you push the “No”, ID78K0R-QB is terminated without preserving a present 
environment. 

 

The Exit confirmation dialog box is 
displayed. 
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3.14 RF Test Program 
 
 
 

3.14.1 Procedure for one to one transmit/receive test 
 

1). Assumption here in this section is, you have two TK-78K0R/KG3+UZ boards, 
in one of which the execution code for the “RF_TEST” was programmed by 
the debugger. You also prepare two PCs or one PC with more than one usb 
interface. 
one PC with USB interface and hyper-terminal to control the transmitter side 
of the board, and the other one with USB interface to the second PC for 
debugging at the receiver board. 

 
 
 

 
 

 
 
 
 

2). Now, you designate the one TK-78K0R/KG3+UZ board loaded with the 
execution code in the previous procedure as a transmitter. Another board, 
which is not loaded with the execution code is now designated as a receiver, 
which send back the test result to the sender. The receiver board can work 
without PC, but now, you set this board to the debug mode. Please set the 
switches on the receiver board as follows. 

 

Receiver Debugger use. 

Execute ID78K0R-TK. 

Transmitter use as Stand alone. 

Execute terminal software. 

Short address : 0001 Short address : 0002 
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JP1 1-2 short (USB side) 

Bit1 ON 
Bit2 ON 
Bit3 ON 
Bit4 OFF 
Bit5 OFF 
Bit6 ON for address setting 
Bit7 OFF for address setting 

SW1 

Bit8 ON for the receive mode 
 
 
The above example is for the short address of 0002. 
There are four ways of the address setting as follows, 
 

Short Address 
 

0001 0002 0003 0004 
Bit6 OFF ON OFF ON 

SW1 
Bit7 OFF OFF ON ON 

 
Please connect the receiver board to your first PC with a USB cable. 
Now, please repeat the procedures described in the section “3.9 Starting 
integrated debugger”. 
You will see the C-source window, as shown below. 
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Now, please click “GO” to run the program. 
 
 

 

 
 

You will see the red bar at the bottom. 
 
Now the receiver board is ready. 
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3). Please set the transmitter board as follows, 
 

JP1 1-2 short (USB side) 
Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 ON 
Bit5 ON 
Bit6 OFF for address setting 
Bit7 OFF for address setting 

SW1 

Bit8 OFF for the Hyperterminal mode 
 
 
This example is for the short address of 0001. 
This board is designated as the transmitter. 
 
Then, please connect it to your second PC with a USB cable. 
 
Then, please identify the COM port number of the USB in your PC  
at [Control Panel]  [System]  
 
 
 

4). Hyper Terminal 
 
On MS-Windows in your PC, please select [All Programs] -> [Accessory] -> 
[Communication] -> [HyperTerminal] 
 
Setting of Hyperterminal 
  

 
 
 
 
 

 
 (Property -> Setting -> ASCII) 
 Local Echo OFF 
 No Line Feed 
 
 

Bits per second 115200 

Data bits 8 

Parity None 

Stop bits 1 

Flow control None 
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Now you will find the following opening menu in the window. 
If not, please try the RESET button on the board. 
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5). Execution of the Transmit/Receive Test 
 
To initiate the PER, Packet Error Rate, test, please press “1” in the menu.  
You will see [My Profile], 
then, be asked for the destination of the PER test, as shown below. 
 

 

 
 
Now, you may input “0002”. 
Then, you will be asked how many packets you wish to consume in the PER test. 
You may input “1000”. 
Then, you will be asked the interval of packets in msec. 
You may input 3 msec. 
Then, the PER test will be executed.  
You will see, 
the number of packets sent, that is, 1000 as you input, 
the number of the received packets, 
the calculated PER in % 
and the maximum and minimum RSSI values in the PER test. 
 
[Note]  
PER= Packet Error Rate 
RSSI= Received Signal Strength Indication 



- 68 - 

 

 
 
RSSI is expressed in the hexagonal value of 256 levels, which indicates the signal 
strength in the received signal. For more details of the RSSI value, please refer to 
the datasheet of the UZ2400 RF chip. 
 
Please note the PER and the RSSI are measured at the receiver side. 
The receiver does not send back the test packets, but only the test result. 
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6). Channel setting 
 
In the previous example, you may have also found the RF channel used in this 
test is the Channel 11. The channel is specified by the IEEE 802.15.4 
specification. 
The channel 11 is assigned at 2405 MHz. You can change the channel in the PER 
test in 5MHz step to the maximum channel of 26th at 2480 MHz. 
To do it, please press “9” in the command prompt. Then, please choose the 
channel by [+], [-], [A], [B], or [C]. In the example below, the channel 23th, 2465 
MHz, was selected.  
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To execute the PER test at the channel 23, press [Enter] in your keyboard, then, 
choose “1” to initiate the PER test mode. Then, you may input 1000 packet in 5 
msec interval to see the following example. Please confirm the channel used is 
23th in the display. Please note the receiver will learn which channel is to be used 
for the test automatically. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

[My Profile] 
------------------------------------- 
  MAC : 22:95:78:01:00:00:00:47 
Short : 0001 
PanID : 2514 
------------------------------------- 
Send to (Short addr) ? : 02 
Send count (dec)     ? : 1000 
Interval (dec/msec)  ? : 5 
[Set channel to 11 (Cmd)] 
Prepare to send..OK 
[Set channel to 23 (Current)] 
Send..     0 
Request to result..OK 
 
 
[Results] 
------------------------------------- 
From     : 0001 
To       : 0002 
------------------------------------- 
Sent     : 1000 
Recieved : 1000 
PER      :   0.0000% 
RSSI     : max FF / min FF 
------------------------------------- 
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7). Adjusting the output power 
 
You may wish to control the output power in the PER test.  
For it, please select “0” in the menu. 
You will be asked the register ID. Please input “203”. 
Then you will see, “LREG[203] : 00 >”. 
It means the current value at the register [203] is 0x00h, which means 0 dB. 
0x00h is the reset default. 
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The register bits are defined as follows, 
 
LREG[203]:  

[7:6] -> large scale tuning 
 00: 0 dB  
01: -10 dB 
10: -20 dB 
11: -30 dB 
[5:3] -> small scale tuning 
000: 0 dB 
001: -1.25 dB 
010: -2.5 dB 
011: -3.75 dB 
100: -5 dB 
101: -6.25 dB 
110: -7.5 db 
111: -8.75 dB 
[2:0] -> 000 

 
For instance, if you wish -15 dB, please input “60”, as follows, 
 
“LREG[203] : 00 > 60”  
 
Then, you will start the PER test. 
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The minimum output power is set by “F8”. 

 
 
You may find larger PER value with smaller RSSI value in this case. 

 
Please note this adjustment is applied only to the transmitter. The receiver always 
sends back the test results with the 0 dB output power using the channel 11th. 
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3.14.2 PER test / receiver 
 
The Menu 2 sets the board to the receiver in the PER test. 
If you have two PCs, you can connect two boards to each of two PCs, then, 
you will apply this mode to one of them.  
In your current case, your receiver board is now being connected to the 
debugger. Therefore, you cannot access to these menu to utilize this mode 
setting. Alternatively, you have set the receiver board to the receiver mode 
by setting the switch 1-8. 
 

3.14.3 Continuous TX / Pseudo Noise 
 

The Menu 3 initiates the modulated RF transmission. The data carried are 
pseudo random numbers. You can define the channel using the menu 9, 
and the output power using the menu 0. 

 
 

3.14.4  Continuous TX / Raw carrier 
 

The Menu 4 initiates the carrier transmission. The output power is not 0 dB 
as a reset default. You can define the channel using the menu 9. 

 

3.14.5 RX Mode 
 

The Menu 5 initiates the receiver mode. 
 

3.14.6 IDLE MODE 
 

The Menu 6 sets the UZ2400 into the IDLE mode. 
 

3.14.7 Sleep MODE 
 

The Menu 7 sets the UZ2400 into the Deep Sleep mode. 
 

 

3.14.8 Standby MODE 
 

The Menu 8 sets the UZ2400 into the Standby mode. 
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3.14.9 Set RF channel 
 

The Menu 9 allows you to set the RF channel. 
 
 

3.14.10 Manually set UZ2400 register 
 
The Menu 0 allows you to set the UZ2400 registers. 
Please refer to the datasheet of the UZ2400 RF chip for the definition of 
registers. 

 
 

3.14.11 Resetting RF 
 

The Menu A allows you to reset the UZ2400 registers. 
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3.15 Creating a new PM + workspace (project) 
 
 
 
You may wish to create a new work space in the PM + to initiate a new project. 
Please select select [File]→[New Workspace...] in the pull-down menu of the PM 
+.  

  

 

 

  

            

 

The dialog box for creating 

New workspace is displayed

<Description of items> 

Workspace File Name: 
 -> Specify the name of the workspace file that 

manages the project files. 
.prw is automatically suffixed as the file 
type. 
A project file (.prj) of the same name is 
simultaneously created. 

Folder: 
 -> Specify the folder for saving the workspace 

file by writing its absolute path. 
    This item can be selected from a reference 

dialog box by pressing the Browse…
button. 

Project Group Name: 
 -> Specify this item if wishing to manage 
multiple projects together in function units.
If nothing is specified, this item is the 
same as the workspace file name. 

Series Name: 
 -> Specify the series name of the device to be 

used. 

Device Name: 
 -> Specify the name of the device to be used.
 

The concrete information set here is 
described on the following pages 
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                                        Push the Next > button. 

 
 

 
 Push the Yes button. 

 
  

Push the Detail setting button   

 

Input the workspace information 
setting as follows. 

Workspace file name 
 → test 

Folder 
 → C:/test 

Project Group Name 
 → Don’t input this item. 

Series Name 
 → 78K0R 

Device Name 
 → uPD78F1168_A0 
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Set the version of tools as follows. 
CC78K0R：W1.20 

RA78K0R：W1.10 

ID78K0R-QB：V3.40 

 

 

Select tools as above screenshot, then click  OK  . 

 

 
Click  Next >   

 

 
Click  Next >   
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Select ID78K0R-QB V3.40 

 

 
 

  
Click  Next >   

 

 

Click  Finish   

 

 

Check the project information 

setting contents. 
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This completes workspace and project creation. 
Additional source files can be registered at any time thereafter. 

For details, refer to ”Registering additional source file”  

 
Also, you need to do the settings for on-chip debug. Please refer to "2.4 Set Linker Options", 
"2.5 Set Compiler Options", and "2.7 Check Debugger Settings". 

 
 

 

Project “test" was registered. 
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3.16 Registering additional source file 

 
 

The method for registering additional source files to a project is described below. 
The following example shows the additional registration of source files “b.c” and “c.c” with 
source file “a.c” already registered. 
Place the cursor on the source file in the Project window of PM +, and select [Add Source 
Files…] displayed in the right-click menu  

 

 

 

 

Select source files “b.c” and “c.c” and 
then press the Open button. 

 

 Multiple source files can be selected by clicking the desired source files where pressing Ctrl key. 
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Source file “b.c” and “c.c” 
are additionally registered 
to the project. 
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3.17 Terminating PM + 
 
 
 
 

In the PM + menu, select [File]→[Save Workspace].  
Then, select [File]→[Close Workspace].  
 
In the PM + menu, select [File]→[Exit PM +].  

 

 

 

 
PM + ends. 
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4 IEEE 802.15.4 MAC Sample Program 
 

 
 
Two sample implementations utilizing the MAC stack are offered in this evaluation 
kit.  
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4.1 The MAC Sample program 1 :TextChat 
 
 
This chapter introduces the usage of MAC application 1 
 

The MAC Sample program 1 is developed to provide with a simple example 
to construct a star network utilizing the IEEE 802.15.4 PHY/MAC standard. 
 
The MAC Sample Program offers, 

1. Designation of a network coordinator in a star configuration 
2. Text chat between a coordinator and an end device 

 
To use the MAC Sample Program 1, you need to prepare at least two PC with 
a USB interface or one PC with more than one USB interface, and two 
TK-78K0R/KG3+UZ boards.  
 
The MAC Sample Program 1 is provided in the form of the C source codes.  
 
If you wish to tailor the sample program to meet your specific needs, you can 
edit the source code, re-compile it with debug build to generate a load 
module file, then, start the debugger to load the tailored execution code on to 
the microcontroller for further debugging on the project manager PM +. In this 
procedure, the Flash programmer is not required. However, because the 
USB connection to instruct operation to the program is occupied for the 
debugging purpose, alternatively, you can make a release build to achieve a 
new hex file, on the project manager PM +. 
 

As a general remark, please respect your local regulation of electro-magnetic 
emission. In general, it is suggested to use the TK-78K0R/KG3+UZ board in 
a radio anechoic chamber. 
 
It supports text chat for one coordinator and 4 end devices. 
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4.1.1 Programming to the TK boards 
 
For chatting, please prepare minimum 2, or maximum 5 TK-78K0R/KG3+UZ boards. 
You need identical numbers of PCs. 
 
 
Some laptop PCs do not support full functionality of hyperterminal. 
This software has been confirmed at 
NEC MATE MY25XCZEG  
and, NEC VERSAPRO VY10F/BH-M 
 
Start PM+, and open the file 
"C:¥TK78K0R¥SAMPLE_KG3+UZ¥TK78K0RKG3UZ_Sample1¥TK78K0RKG3UZ_Sa
mple1.prw". 
 
Select "Tools" on menu bar, then "Compiler options". 
 
Select "Preprocessor" tab on "Compiler Options" window. 
 
To write programs on the first TK-78K0R/KG3+UZ, enter 
"CPU78K0R,MAC_ADDR=0x0001" on "Define Macro". For the second and third 
TK-78K0R/KG3+UZ, enter "CPU78K0R,MAC_ADDR=0x0002" and 
"CPU78K0R,MAC_ADDR=0x0003". The number "x" of " MAC_ADDR=x" must be a 
unique number. 
 
Click re-build button on PM+ or select "Build" -> "Rebuild" on menu bar to rebuild. 
 
Start the debugger from PM+, then write different programs to each TK-78K0R/KG3+UZ 
(for the information about how to write programs, refer to "3.1 Starting PM+" through "3.9 
Starting integrated debugger (ID78K0R-QB)").) 
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4.1.2 Setting up the board to your PC 
 
Set the TK-78K0R/KG3+UZ as shown below. 
Connect it to PC with USB cable. 
Confirm the power LED on TK-78K0R/KG3+UZ is lighted.  
 

JP1 1-2short (USB side) 
Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 ON 
Bit5 ON 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
 
Start Hyper Terminal with referring to "3.14 RF Test Program". 
 
Settings of the Hyper Terminal should be set as follows. 
 

 
 
 
 
 

 
Press SW5 (RESET SW) once after Hyper Terminal is started. The sample application starts 
after resetting. 
 
In the same way, connect the other TK-78K0R/KG3+UZ board to PC, and start Hyper 
Terminal. If the PC has more than one USB ports, you can connect to more than one 
TK-78K0R/KG3+UZ boards, and you can start more than one Hyper Terminals for those 
COM ports on each board. 

Bits per second 115200 

Data bits 8 

Parity None 

Stop bits 1 

Flow control None 
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4). Hyper Terminal 
 

Now you will find the following opening menu in the window. 
If not, please try the RESET button on the board. 
 

 
 
Then, press Enter, 
 

 
 
Please do the same for your other boards and PCs. 

----------------------------------------- 

  TK-78K0R+UZ Sample Application 

----------------------------------------- 

  2007 Skyley Networks 

 

  MY MAC extended address 

  =123412349ABC001 

 

  Command > 

[Help] ------------------------- 

S: Send Message 

M: MLME Associate test 

C: Start Coordinator test 

-------------------------------- 

 

Command? > 
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4.1.3 Designation of a coordinator 
 

Now, you must decide which board is a coordinator. 
Go to the PC of the coordinator board, and press C. 
 

 
 
Now the coordinator has started. 

 

4.1.4 Network Association 
 

For other PCs for other boards, please press M. 
 

 
 
Now, this particular board was associated to the network as an end device 
with the short address of 4321. Please repeat this step for your third, fourth, 
and possibly fifth board. 
 

Command? >M 

 

> MLME-ASSOCIATE.request 

> MLME-ASSOCIATE.confirm 

>  Associated ShortAddr:4321 

>                Status:00 

 

Command? > 

Command? >C 

 

> MLME-START.request 

> MLME-START.confirm 

>  Status:00 

 

Command? > 
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On the coordinator side, you will find the following message, if the 
association is successful. 
 

 
 

 

4.1.5 Text Chat 
 

Now the network is prepared for you to start text chat between an end 
device and the coordinator. 
 
At first, you may start with the coordinator. 
 
Press S, then input the short address of an end device, 4321 in this 
example, 
then, input your text message, up to 102 bytes.  
 

 
 
 

 

Command? >S 

 

> MCPS-DATA.request 

> Send to (short address) ? 4321 

> Message ? Hello! 

 

Command? > 

> MLME-ASSOCIATE.indication 

>  from 123400019ABC0001 associated to 4321 

 

[Help] ------------------------- 

S: Send Message 

-------------------------------- 

 

Command? > 
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You will find the following message on the end device, 4321. 
The sender’s short address is “1975”, and the PAN ID is 2420 in this 
example. 
 

 
 
Now, you can reply from the end device “4321” to the coordinator “1975” by 
inputting S, 1975, and your reply text. 
 
 

 
 
 

Command? > 

> MCPS-DATA.indication 

>  from 1975/2420 

Hello! 
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4.2 The MAC Sample Program2 : LED Control 
 
 
 
The MAC Sample program 2 is developed to provide with another simple example 
to construct a star network utilizing the IEEE 802.15.4 PHY/MAC standard. 
 
The MAC Sample Program 2 offers, 
1). Designation of a network coordinator in a star configuration 
2). If you push a switch on the n th end device, an LED on the coordinator board 
blinks on and off n times. 
 
To use the MAC Sample Program 2, you need to prepare one PC with a USB 
interface and two TK-78K0R/KG3+UZ boards or more boards, up to 5.  
The MAC Sample Program 2 is provided in the form of the C source codes with 
the MAC library.  
 
If you wish to tailor the sample program to meet your specific experiment, you can 
edit the source code, re-compile it with debug build to generate a load module file, 
then, start the debugger to load the tailored execution code on to the 
microcontroller for further debugging on the project manager PM +. In this 
procedure, the Flash programmer is not required. However, because the USB 
connection is occupied for the debugging interface, the USB connection is not 
available for applications. In this application example, Hyperterminal with USB 
connection offers information on the network association. However, the LED 
operation can be made without Hyperterminal. Therefore, you can use the USB 
connection for debugging for the LED operation. Alternatively, you may make a 
release build to achieve a new hex file, on the project manager PM +.  
 

As a general remark, please respect your local regulation of electro-magnetic 
emission. In general, it is suggested to use the TK-78K0R/KG3+UZ board in a 
radio anechoic chamber. 
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4.2.1 Programming to the TK boards 
 

Prepare TK-78K0R/KG3+UZ boards (2 to maximum of 6 boards). 
You also need at least one PC to write programs, however no PC is needed when running the 
programs. 
 
One TK-78K0R/KG3+UZ board will be "Coordinator". Other 1-5 boards will be "End device". 
You use the same project files for both "Coordinator" and "End device". 
 
Start PM+ and open the file 
"C:¥TK78K0R¥SAMPLE_KG3+UZ¥TK78K0RKG3UZ_Sample2¥TK78K0RKG3UZ_Sample2.
prw". 
 

Click the build button    or select "Build" on menu bar, then "Build" to build. 
Start the debugger from PM+ and write programs to each TK-78K0R/KG3+UZ board. 
(for the information about how to write programs, refer to "3.1 Starting PM+" through "3.9 
Starting integrated debugger (ID78K0R-QB)") 
 
The address of each board will be set by pressing SW2 when the boards start up (when 
power is supplied). Therefore, you use the same programs to all boards. 

 

4.2.2 Starting up a coordinator 
 
 

By connecting the TK-78K0R/KG3+UZ which takes the role of "Coordinator", you can monitor 
those programs running (you can monitor the output itself with LED without PC). 
When you wish to connect PC, set the TK-78K0R/KG3+UZ as follows. Then, connect USB 
cable to PC. Confirm the power LED is lighted after connecting the USB cable. 
 

JP1 1-2 short (USB side) 
Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 ON 
Bit5 ON 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
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Start Hyper Terminal with referring to "3.14 RF Test Program". 
 
Settings of the Hyper Terminal should be set as follows. 

 
 
 
 
 
 

 
 

6). After you open the window of the HyperTerminal, please push the reset 
button on the board. Now you will find the following opening message in 
the window. 
If not, please reconfirm the COM port number of the USB connection. 

 

 
Now the coordinator has started up successfully. 

Bits per second 115200 

Data bits 8 

Parity None 

Stop bits 1 

Flow control None 
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4.2.3 Starting up end devices 
 

Set TK-78K0R/KG3+UZ settings as follows when you use PC connected to 
TK-78K0R/KG3+UZ which takes the role of "End device". Then, connect USB cable to PC. 
Confirm the power LED is lighted after connecting the USB cable. 

 
JP1 1-2 short (USB side) 

Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 ON 
Bit5 ON 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
 
 

When you wish to use TK-78K0R/KG3+UZ as itself, set JP1 to BATTERY side (2-3short) and 
SW1 to all OFF, then connect battery. 
 
You must set the position of SW2 when you supply power to TK-78K0R/KG3+UZ. 
The TK-78K0R/KG3+UZ board functions of each SW2 position are described as follows. 

 
 

Position of Joy Stick during 
start-up 

Function Extended Address 

Default Coordinator 0x1234XXXX9ABC0001 
Up End Device 0x1234XXXX9ABC0002 
Center End Device 0x1234XXXX9ABC0003 
Left End Device 0x1234XXXX9ABC0004 
Right End Device 0x1234XXXX9ABC0005 
Down End Device 0x1234XXXX9ABC0006 

※The “XXXX”of Extended Address filled with”MAC_ADDR=0xXXXX” that configured 
at “Compiler Options” -> “Defined Macro”.
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If you start-up a board while keeping the Joy Stick up, you will see the 
following message on the HyperTerminal. 
 

 
 
A short address of “4352” was assigned to the board. 
A short address is assigned sequentially, independent from the long 
address. 
Then, if you start-up the third board while keeping the Joy Stick center, you 
will see the following message on the HyperTerminal. 
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4.2.4 Operation 
 
The coordinator generates beacon at channel 11 of 2405 MHz. 
LED4 on the board is ON. 
 
An end device makes a network association. If successful, LED2 on the 
board is ON. 
 
If you push SW3 on an end device, LED4 on the coordinator blinks. 
And, if you push SW4 on an end device, LED3 on the coordinator blinks. 
 
The number of times of blink depends on the sequence the end device joined 
in the network. For instance, if an end device is the third end device for the 
network, the LED will blink three times. 
 

LED on Coordinator SW on End Device 
LED2 SW3 
LED3 SW4 

 
The following example shows, the SW3 on the fifth end device, “4356”, was 
pushed. You will see the LED2 on the coordinator will blink 5 times.  
The default PAN ID of this network is “2420”.  
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5 Mode setting of the board 
 

 
 
 
The combination table of the switch of this board is shown. 
 
 
 
 
 
 
 
 
 
 
 
  
 
  
 
 
 
 
 

Usage case 
SW 

Normal  Debug  (USB 
Connection) 

Normal (Serial 
Connection) 

JP1 
Select by power 
supply source 

1-2short (USB side) 1-2short(USB side) 

Bit1 OFF OFF/ON  ※1 OFF 
Bit2 OFF ON OFF 

Bit3 OFF ON OFF 

Bit4 OFF OFF ON 

SW1 

Bit5 OFF OFF ON 
 
※1 

ON: The microcontroller stays being reset until ID78K0R-QB is started. 
OFF: The microcontroller runs the programs stored in the flash memory as 

soon as it gets power supply.  

SW1 
JP1 
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6 Revision History 
 
 
 
 

Revision  Contents Date 
Rev. 1.0 Initial Version April 2, 2007 
Rev. 2.0 Correction With the sample program 

change. 
July 2, 2007 

Rev. 3.0 Correction With the sample program 
change. 

March 31, 2008 

Rev. 3.1 Manufacturer change. June 24, 2008 
Rev. 4.0 Correction With the sample program 

change. 
March 7, 2009 

 


